User Guide
(Version 5.05)

?

COPYRIGHT NOTICE
Constant Energy 1987-2012
All rights reserved

Copyright exists on the contents of this User Guide and the software ‘P leW.exe’ supplied on the
accompanying electronic media. You agree by purchasing the software to use it on only one machine.
However, it may be transferred and used on another machine, but shall under no circumstances be
used on more than one machine at a time. One copy can be made of the software into any machine
readable form for backup purposes only in support of your use of the software on a single machine.

DISCLAIMER OF WARRANTY
The software and User Guide are sold AS IS and without warranty as to performance. Because of the
use to which this software may be put, and the variety of luminaire I-tables and hardware used in
conjunction with it, no warranty of fitness for a particular purpose is offered. Whilst the developer has
invested considerable time and effort to create a high quality product, the user must assume the risk of
using this software.

Constant Energy
Pestana House
67 Springwood Road
SPRINGWOOD, Qld 4127
AUSTRALIA
Email: support@perfectlite.com
Web: www.perfectlite.com

Perfect Lite for Windows – User Guide (Version 5.05)

Page 2

Table of Contents
1.
1.1
1.2
1.3
1.3.1
1.3.2
1.3.3
1.3.4
1.3.5
2.
3.
3.1
3.2
3.3
3.4
4.
5.
5.1
5.2
6.
6.1
6.2
6.3
6.4
7.
7.1
7.2
7.3
7.4
7.5
7.6
8.
8.1
8.1.1
8.1.2
8.1.3
8.2
8.2.1
8.2.2
8.3
8.4
8.4.1
8.4.2
8.4.3
8.4.4
8.4.5
8.4.6
8.5
8.6
8.7
8.7.1
8.7.2
8.8
8.8.1
8.8.2
8.8.3
9.
10.
11.
12.

READ THIS SECTION FIRST ...............................................................................................................................................5
Upgrading from the DOS PLE Software ..................................................................................................................5
On Line Help ...............................................................................................................................................................5
Menu System ..............................................................................................................................................................6
File Menu ..............................................................................................................................................................6
Luminaire Library Menu ....................................................................................................................................6
Project Menu........................................................................................................................................................7
Tools Menu...........................................................................................................................................................8
Help Menu ............................................................................................................................................................9
INSTALLATION....................................................................................................................................................................10
PROGRAM OPTIONS.........................................................................................................................................................11
General Tab ................................................................................................................................................................11
Plotter Tab ..................................................................................................................................................................12
Manufacturers Tab ...................................................................................................................................................12
DXF Layers Tab...........................................................................................................................................................13
IMPORTING EXISTING DOS PERFECT LITE FILES ...........................................................................................................15
MAIN MENU SCREEN ........................................................................................................................................................17
Exiting the Program...................................................................................................................................................17
Re-starting the Program...........................................................................................................................................17
LUMINAIRE LIBRARY MENU .............................................................................................................................................18
Summary List..............................................................................................................................................................18
Photometric Report...................................................................................................................................................19
Intensity Distribution Curves..................................................................................................................................20
Add Photometric Data to PLEW Library.................................................................................................................22
TOOLS MENU .....................................................................................................................................................................24
P Category Lighting....................................................................................................................................................24
V Category Lighting....................................................................................................................................................25
IESNA to CIE/SAASTAN Conversion..........................................................................................................................26
CIE/SAASTAN to IESNA Conversion..........................................................................................................................27
Zebra Crossing Design..............................................................................................................................................27
Upward Waste Light Ratio.......................................................................................................................................30
PROJECT MENU .................................................................................................................................................................32
New Project.................................................................................................................................................................32
File Name and Job Title......................................................................................................................................32
Locating Poles and Attaching Luminaires ......................................................................................................32
Additional Buttons..............................................................................................................................................34
Define Calculation Field ..........................................................................................................................................35
Calculation Type .................................................................................................................................................35
Grid Dimensions .................................................................................................................................................35
Calculate .....................................................................................................................................................................36
Isolux Diagram ..........................................................................................................................................................37
Mounting Positions and Aim Points ...............................................................................................................38
Display Statistics ................................................................................................................................................39
Levels at Grid Points...........................................................................................................................................39
Zoom into Smaller Area .....................................................................................................................................39
Graphics Printer Output....................................................................................................................................40
AutoCAD DXF File Creation ................................................................................................................................41
Quick Display of Results ..........................................................................................................................................42
Uniformity Window Information ...........................................................................................................................44
Archiving Results.......................................................................................................................................................45
Archive ..................................................................................................................................................................46
Unarchiving a Previous Project .......................................................................................................................46
Modify Project ...........................................................................................................................................................48
Input Filename, Output Filename and Job Title ............................................................................................48
Modify Method Menu.........................................................................................................................................49
Exchanging Luminaire Types.............................................................................................................................49
HELP MENU ........................................................................................................................................................................52
CONCLUSION.....................................................................................................................................................................53
SAMPLE PROJECT - TENNIS COURT ...............................................................................................................................54
SAMPLE PRINTER OUTPUT ...............................................................................................................................................55

Perfect Lite for Windows – User Guide (Version 5.05)

Page 3

(Page intentionally left blank)

Perfect Lite for Windows – User Guide (Version 5.05)

Page 4

1. READ THIS SECTION FIRST
This User Guide describes in brief detail some of the main features of the Perfect Lite for Windows software. It has
primarily been designed for a first time user of the software so please proceed through the User Guide sequentially to
obtain its full benefit.
In any event, much of the information contained in this document, and the various separate user manuals, is now
available directly through the On-line Help feature of the programs. So to some extent fully reading of the manual/s
is somewhat superfluous.
The screen captures shown throughout this document are from a Windows XP (32 bit) installation of the software,
actual Vista and Windows 7 screens do not generally appear significantly different.

1.1 Upgrading from the DOS PLE Software
If you are upgrading from the previous DOS Perfect Lite Illuminance calculation software (PLE.exe) then you can
possibly skim through the guide to generally get the feel of the new program. However, at least read the remainder of
Section 1 to familiarise yourself with the new menu structure. Many of the menu selections are similar, if not, the
same as the previous program. The flow of the program and input screens are much the same but with the usual
Windows GUI interface.
Section 3 and 4 must be read in detail in order to import data from the previous DOS software.

1.2 On Line Help
Several times during this User Guide you will be asked to press the F1 key in order to obtain more details about the
field where the mouse/text cursor is located. This will save me from describing them in the User Guide and allow you
to become more familiar with using the program's On Line Help facilities. See also Section 9 at the end of this
document.
N.B. This help facility uses a program called WinHlp32.exe to display all the Help windows. This program is no longer
provided with Microsoft Vista and Windows 7 operating systems. If you receive a message like below, when pressing the
F1 key, then you will have to download the free WinHlp32 software from the Microsoft website. See either
http://www.perfectlite.com/HelpFix.htm
or
http://support.microsoft.com/kb/917607/en-us

Each major Section of this User Guide begins from the main Perfect Lite for Windows menu and therefore if at any
time the program seems to become unsynchronised with the User Guide then by pressing the Exit button one or more
times you should return to the Perfect Lite for Windows menu where you can begin that Section again.
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1.3 Menu System
Below are the various menus now available in the Perfect Lite for Windows program. A brief indication of what each
selection covers follows the image. When running the program some of the selections on a menu may be ‘greyed out’,
this means they are not available to choose at that time. For example if you have not completed the Calculate
selection on the Project menu (i.e. not done an illuminance calculation) then the Isolux Diagram option will be ‘greyed
out’.

1.3.1 File Menu

Selections from this menu are:New Project

use this selection to begin a new lighting design project, all the previous
calculation data will be erased. However, a question will be asked if you
wish to Save/Archive the last project before continuing.

Retrieve Project (from Archive)

use this selection to restore a previously archived project (see next
selection). Upon restoring, all the files & calculation results of the
nominated project will be loaded as they were when archived.

Save Project (Archive)

use this selection to archive the current project and state of the program
including layout, shape & DXF files and calculation grid etc..

Exit

use this selection to close down the program. You can also click on the
[X] at top right-hand corner of the program window.

1.3.2 Luminaire Library Menu

Selections from this menu are:Add Luminaire

use this selection to add new luminaire photometric i-table data into the
Library maintained within the program. The Summary listing files will be
automatically updated after this process is completed.
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Delete Luminaire

use this selection to delete an existing luminaire from the Library. The
luminaire is not actually removed from the Library just ‘flagged’ as deleted.
The Summary listing files will be automatically updated after this process
is completed.

Change Luminaire Code No.

use this selection to change the code number of an existing luminaire in the
Library. The Summary listing files will be automatically updated after this
process is completed.

Replace Luminaire Description

use this selection to replace the description of an existing luminaire in the
Library. The Summary listing files will be automatically updated after this
process is completed.

View Luminaire I-table

use this selection to display the actual i-table of an existing luminaire in
the Library in a tabular format. The resulting display can be printed or
saved to a text file if required.

Summary List

use this selection to display a summary listing of all the luminaires in the
Library. The resulting display can be printed or saved to a text file if
required.

Update Summary List Files

Very occasionally, the Summary listing (above selection) may get out of
synchronization with what you might think is in the Library. In this case,
use this selection to force the program to regenerate the Summary listing
files.

Library Compaction

use this selection to compress the Library files and permanently removing
any luminaires ‘flagged’ as deleted.

Make Backup Copy

use this selection to make a backup copy of the Library files, a message will
be given as to where the copy has been saved. These files can be used to
transfer your whole of luminaires to another user of Perfect Lite for
Windows

Intensity Distribution Curves

use this selection to display intensity distribution curves for a nominated
luminaire from the Library.

1.3.3 Project Menu

Selections from this menu are:New Layout

use this selection to create a ‘new’ layout file, for the current project, containing
the pole locations and luminaires mounted on them. This option will be
automatically invoked when choosing a New Project from the File menu. The
program will then automatically invoke the Define Calculation Grid selection
mentioned below.

Modify Layout

use this selection to modify a previously saved layout file. By default, the
previously saved layout file will be the last one used. The program will then
automatically invoke the Calculate selection mentioned below.

Define Calculation Grid

use this selection to define the size of the calculation grid, illuminance (or
luminance) type and associated parameters.
The program will then
automatically invoke the Calculate selection mentioned below.
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Calculate

use this selection to perform the respective calculations defined in the previous
menu selection using the current layout file.
The program will then
automatically invoke the Isolux Diagram selection mentioned below.

Uniformity Windows

use this selection to nominate up to three rectangular windows within the
calculation grid over which the minimum, maximum, average & several
uniformity values will be calculated.

Quick Display of Results

use this selection to display the results of the calculations etc. on the screen.
You will then be able to print these to a printer or save them to a text file.

Isolux Diagram

use this selection to show the calculated results in contour form. Within the
selection you will be able to import a DXF file and zoom into a smaller area of
the calculation grid. As well you will be able to create a DXF file of the results,
print to a printer & plot to a plotter etc.

1.3.4 Tools Menu

Selections from this menu are:Import PLE Data Files

use this selection when upgrading from the ‘old’ DOS PLE software
(Ple.exe). It transfers over all your Library and working files etc. to
the new folder structure so your new setup of Perfect Lite for
Windows will effectively match your old setup. It is imperative that
you first complete the Options… menu selection from the Tools menu.

P Category Lighting

use this selection to run a session of the P Category Lighting
software (PlePcat.exe) from the default folder set in the Options…
menu selection.

V Category Lighting

use this selection to run a session of the V Category Lighting
software (PleVcat.exe) from the default folder set in the Options…
menu selection.

I-table Conversion Modules >
IESNA to CIE-SAASTAN

use this selection to run a session of the IESNA to CIE-SAASTAN
Conversion software (PleI2C.exe) from the default folder c:\Program
Files\Perfect Lite\IESNA to CIE-SAASTAN\.

CIE-SAASTAN to IESNA

use this selection to run a session of the CIE-SAASTAN to IESNA
Conversion software (PleC2I.exe) from the default folder c:\Program
Files\Perfect Lite\ CIE-SAASTAN to IESNA \.

I-table to CSV

use this selection to run a session of the I-table to CSV software
(PleI2CSV.exe) from the default folder c:\Program Files\Perfect Lite\.
This converts IESNA and CIE/SAASTAN i-table files to annotated CSV
files that can be imported into Microsoft Excel.

Zebra Crossing Lighting Design >
AS11584 - 1987

use this selection to assess a lighting design for a zebra crossing in
respect of AS 1158.4 – 1987.

AS/NZS1158.4:2009 - Australia

use this selection to assess a lighting design for a zebra crossing
(Australia parameters) in respect of AS/NZS 1158.4:2009.
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AS/NZS1158.4:2009 - New Zealand

use this selection to assess a lighting design for a zebra crossing
(New Zealand parameters) in respect of AS/NZS 1158.4:2009.

Upward Waste Light Ratio

use this selection to calculate the Upward Waste Light Ratio of a
luminaire for various upcast angles.

Cleanup Working Files

use this selection to manually delete some of the various working
files accumulated during the running of Perfect Lite for Windows.
Generally, this is taken care of within the program but you may wish
to delete unwanted layout, shape, DXF files etc. (particularly if the
project has been archived).

Change Password

use this selection to change the password required to gain access to
the program.

Options…

use this selection to set the many optional parameters used within
the program. When you first run Perfect Lite for Windows this menu
selection will be automatically invoked so you can setup the
program to your liking.

1.3.5 Help Menu

Selections from this menu are:Contents

displays a screen with hyperlinks to common Help topics.

User Guide

use this selection to display the program User Guide (i.e. this
document) giving a general run through the program showing how it
operates.

Update History

displays a list of recent updates to the program.

Terminology

displays an alphabetical listing of terminology used in the AS/NZS
Standard series.

Show Welcome Screen at Startup

select this (will put a tick to the left of the menu item) to display the
‘Welcome’ screen each time the program starts.

Check for Updates at Startup

select this (will put a tick to the left of the menu item) to have the
program automatically check for updates. A functioning internet
connection is required.

About

displays the version number & built date of the program plus other
contact information for support etc.

More information on these menus and action that happens will be discussed further down in this document.
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2. INSTALLATION
The software will be provided via Email or Download from the website. Instructions will be provided in the email or
on the website on the procedure to install the software in this case.
It is recommended you choose the default folder eg. c:\Program Files\Perfect Lite or (c:\Program Files (x86)\Perfect
Lite\ on 64bit operating systems) in which to install the software. If you install it in another drive and/or folder then
please make a note of the location below.
Perfect Lite for Windows software installed in:
………………………………………………..…………………………………………………………………………………………………………..
When the installation has finished click on the Start button, select All Programs, then Perfect Lite, then Perfect Lite
for Windows to start the program, see below.

When the program is initially loaded into memory you may see several message indicating this is a first time
installation. In this case, the program should immediately display a message indicating various default parameters
need to be set up. Click on the Ok button to clear this message and inform the program to continue with the set up
process.
The next Section describes the setting up of these various default parameters.
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3. PROGRAM OPTIONS
If the program does not automatically go to this menu selection you can do it manually by choosing the Option…
selection from the Tools menu.

Many of the fields in the screens below will be filled with suggested values derived from your computer system. You
can keep them as they are or change them as you wish. Either way validation checks will be made by the program
that the data entered is correct and within the limits managed by the program.

3.1 General Tab

If you are in doubt as to what information can be entered into any field or what a particular radio button means then
put the cursor in that field & press the F1 key to bring up a small Help window.
Note: In Perfect Lite for Windows you are able to nominate an alternate folder for Library files and Project files to
where the program/system files reside, see fields in the middle of this screen. This may be of use where your
company has several copies of Perfect Lite for Windows but wish to only maintain one Library of photometric itables. In this case, a network drive/folder location could be nominated where everyone can access. The bottom
three fields are where the other ‘standalone’ components of the Perfect Lite software package are installed.
Perfect Lite for Windows – User Guide (Version 5.05)
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After you have modified any of the fields click on the Plotter tab at the top to move to the next page.

3.2 Plotter Tab

This tab tells the program if you have access to an XY pen plotter (this would NOT be applicable to most users). If
you do not have plotter then click on the None radio button otherwise fill in the fields as necessary. Use the F1 key
for any field where you do not understand the meaning.
After you have modified any of the fields click on the Manufacturers tab to move to the next page.

3.3 Manufacturers Tab

This tab indicates the manufacturer's name to be associated with the first one or two digits of the luminaire code
number in the Library of photometric data maintained by the program. By way of explanation, a Luminaire Code
Perfect Lite for Windows – User Guide (Version 5.05)
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number consists of either four or five digits (i.e. numbers between 1001 and 31999). The first one or two digits (eg. 1
to 31) equates to the manufacturer's code with the name as on the fields on this tab. For the moment just leave this
screen as it is, later on, when you start adding I-table data you can decide what luminaire manufacturer you want to
maintain photometric data for and change these assignments accordingly. N.B. See Section 4 on how to import your
existing DOS Perfect Lite Library.
After you have modified any of the fields click on the DXF Layers tab to move to the next page.

3.4 DXF Layers Tab

This tab is used if you have access to AutoCAD ? and wish to create DXF files in Perfect Lite for Windows for importing
back into a drawing in AutoCAD ? . Use the F1 key to check on the contents of each column field, pay particular
attention to the Text Style Name field at the bottom. If you do not have access to AutoCAD then just leave the fields
with the default values.
Now press the Save button to carry out the validation process on all pages and save these parameter for use
elsewhere in the program.
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If an error is encountered, the program will display an error message (click on the Help button to provide more
information about the error). After clicking the Ok button, the cursor will be placed back in the field that triggered
the error. Correct the data in that field and then press Save again. Below is a sample error message and the
respective Help window.
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4. IMPORTING EXISTING DOS PERFECT LITE FILES
N.B. You ONLY need to carry out the instructions in this Section if you previously purchased and have installed on your
computer (or Network) the DOS PLE software i.e. pre April 2011. This software is by default installed in the c:\ple folder,
however, you may have installed it elsewhere eg. On d: drive or a convenient network drive. The PLE program is
characterised by the following menu screen.

This Section describes how to simply transfer over all the Library, layout, Shape, DXF etc. files from your existing DOS
Perfect Lite software installation. This way your new Perfect Lite for Windows installation will effectively be the
same as your ‘old’ DOS system. This is particularly usef ul if you have an elaborate Library of luminaire i -tables.
N.B. This transfer is only allowed once and files subsequently created in Perfect Lite for Windows are NOT
backwards compatible with the previous DOS version. Really there should be no need to use the DOS program
anymore.
To start the transfer process, select the Import PLE Data Files option from the Tools menu.

Click Yes to the subsequent question.
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The following screen will appear where you need to select where your previous DOS Perfect Lite software is located.
The ‘normal’ default location will be displayed but you may have your software installed in a different folder eg. on
d: drive or a convenient network drive. If in doubt, do a search on your computer for the file PLE.EXE.

Click the Continue button to start the import process. Generally, there are no issues with this transfer and a window
on this screen will list all the files processed and action taken.

Click on the Finish button to exit this part of the program when completed.
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5. MAIN MENU SCREEN
The main menu screen for PERFECT LITE for Windows is shown below. It is from this point that all of the features of
the program can be accessed. The screen (or window) can be resized if you like or even made full screen. Minimising
it at times may also be useful if you want to work on another program.

5.1 Exiting the Program
Let us quickly exit the program, this can be done in one of two ways. Either clicking on the File menu and then Exit or
just clicking on the [X] at the top right-hand corner of the program window. Depending on what you selected on the
Options… menu, you may be prompted with a question asking you to confirm termination (press Yes).
This is how you would normally finish the program, the current state of the program is automatically saved so next
time you start the program it will be set up as you left off.

5.2 Re-starting the Program
Let us re-start the program, same as before, click on the Start button, select Perfect Lite, then Perfect Lite for
Windows.. You might see several pop up messages appear on the screen indicating the program is installing itself as
you left off. When complete the main menu screen will be displayed again for you to make a further selection.
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6. LUMINAIRE LIBRARY MENU
On the main Perfect Lite for Windows menu select Luminaire Library, this will bring up the menu, as shown below.

6.1 Summary List
Click on the Summary List item from the menu and a summary listing of all the luminaires in Library will be shown,
see below. If this is a first time installation it will just show a series of evaluation luminaires (indicated as Sample
Data under the Manufacturer heading).

This style of results display window will be shown at several other points in the program. When displayed you can
Print this listing to your default printer or Save As… to a text file by clicking on the relevant button. Clicking on Close
will return to where you can select an individual manufacturer to list, see below. Clicking on Exit will return to the
main menu screen.
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6.2 Photometric Report
Click on the View Luminaire I-table item from the menu and initially a summary listing of all luminaires in the
Library will be shown. ‘Double click’ on the luminaire that you want listed, see below as an example.

From here you can print or save the data, click on Close when finished.
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6.3 Intensity Distribution Curves
Click on the Intensity Distribution Curves item from the menu and on the subsequent data input screen input 1 into
the first field.

Move the cursor to the second field, press the F1 key and read what effect entering data into this field has on the
output. Remove the help window (by pressing Ok), leave this second field blank and press the Display button for the
program to draw the first curve, example below.
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Several things can be done with the display as indicated by the buttons on the bottom right-hand side of the screen.
Note that this luminaire has been photometered in the C-Gamma system.
Let us now look at one photometered in the B-Beta system, click on Exit to return to the previous data input screen
and input 21 into the top field and click on Display. As can be seen below, the diagram is very much different, view
each of the buttons on the top right-hand corner of the screen, they are very much the same as before.
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When finished click on Exit twice to return to the main menu screen.

6.4 Add Photometric Data to PLEW Library
The first choice on the Luminaire Library menu is to add photometric I-table data into the Library incorporated in the
program. Unfortunately, in the evaluation/demonstration version of the program this option is not available (‘greyed
out’). For your information luminaires can be simply added to the Library from photometric data provided by
manufacturers (on disk files) in either the IES (North America) or CIE/SAASTAN street light formats.
By way of example, the following screens would appear (in the full version) when selecting this option requiring
appropriate inputs to load photometric data into the Library.

Select the relevant menu item

Choose files to add (can be multiple selections)

Click Process button
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Fill in data fields not already completed by default values or values read from the input file

Acknowledgement of addition to Library.
I will leave the remainder of the other choices from the Luminaire Library menu up to you to explore at a later time.
For simplicity we will skip over the Project menu at the moment and discuss it in more detail later on in the User
Guide. In the meantime, we will move onto the Tools menu.
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7. TOOLS MENU
From the Tools menu you can access many of the other modules in the Perfect Lite range of software. Some of these
modules are standalone programs (eg. P Category) and others are inbuilt modules (eg. Zebra crossing).

7.1 P Category Lighting
The P Category Lighting program (PlePcat.exe) was the first of the Windows based applications in the Perfect Lite
range of lighting design software. It was developed in conjunction with the release of AS/NZS1158.3.1-2005.
I will not go into detail about this program here as it is contained in a separate user manual. If you wish, you could
explore this module by yourself at a later time as a photometric I-table data file has been supplied for evaluation
purposes. It is named LUM2.CIE and is a typical 80 watt High Pressure Mercury Vapour street light luminaire.
Below is one of the main screens from the program.

Another way to run the program is to click on the Windows Start button, select All Programs , select Perfect Lite and
finally click on P Category Lighting.
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7.2 V Category Lighting
The V Category Lighting program (PleVcat.exe) was the second of the Windows based applications in the Perfect Lite
range of lighting design software. It was developed in conjunction with the release of AS/NZS1158.3.1-2005.
I will not go into detail about this program here as it is contained in a separate user manual. If you wish, you could
explore this module by yourself at a later time as a photometric I-table data file has been supplied for evaluation
purposes. It is named LUM3.CIE and is a typical 250 watt High Pressure Sodium Vapour street light luminaire. Below
is one of the main screens from the program.

Another way to run the program is to click on the Windows Start button, select All Programs, select Perfect Lite and
finally click on V Category Lighting.
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7.3 IESNA to CIE/SAASTAN Conversion
This is a recently added component to the Perfect Lite package and is used to convert photometric i-tables files in the
IESNA format to the CIE/SAASTAN format suitable for use in the P Category, V Category & Upward Waste Light Ratio
software.
I will not go into detail about this program here as it is contained in a separate user manual. Below is one of the
main screens from the program.

Another way to run the program is to click on the Windows Start button, select All Programs, select Perfect Lite and
finally click on IESNA to CIE-SAASTAN.
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7.4 CIE/SAASTAN to IESNA Conversion
This is an additional component to the Perfect Lite package and is used to convert photometric i-tables files in the
CIE/SAASTAN format to the IESNA format. IESNA formatted i-table files are required by some other lighting calculation
software.
I will not go into detail about this program here as it is contained in a separate user manual. Below is one of the
main screens from the program.

Another way to run the program is to click on the Windows Start button, select All Programs, select Perfect Lite and
finally click on CIE-SAASTAN to IESNA.

7.5 Zebra Crossing Design
To design the lighting for a Pedestrian Zebra Crossing using the Project menu (discussed later) in Perfect Lite for
Windows would be (and I freely admit it) somewhat tedious in setting out the calculation fields both for ground level
and 1.5 metres above ground. As they say, “necessity is the mother of invention”, so I developed a special program to
make this task much, much simpler.
This special program is accessed by selecting the Zebra Crossing Design item on the main Perfect Lite for Windows
menu. There are in fact 3 choices that can be made, I will discuss the middle choice in detail, the others are much the
same but for slightly different purposes.
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The data input screen that will initially appear is shown below and is a schematic representation of a zebra crossing
for half the width of the roadway.

Fill in the fields with the values as shown above and then click on the Calculate button. If in doubt as to what value
should go in any field then put the cursor in the relevant field and press the F1 key for Help.
Sample results from this calculation are shown below, by clicking on the Yes button a copy of these result will be
sent to your printer. The screen shows in green, values that meet the minimum requirements set out in the relevant
AS/NZS1158 Category (sometimes referred to as the Code). Those that don’t comply will be shown in red.
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The program will then return back to the starting input screen. Several other buttons are available on this screen,
namely:Library
Lamp Flux
Optimise
Review

displays a summary listing of luminaires in the Library
display the contents of file QUIKLIST.FLX which is user editable (contains typical wattage &
associated flux values)
Finds the various solutions that comply with the Code by varying the aim point
Displays all the complying solutions from the Optimise process

Let’s now click on the Optimise button, a summary result screen will eventually appear as below.

The numbers in the blue area show the individual complying soluti on and approximate aim point. By clicking on the
Yes button a copy of this result screen can be sent to your printer. After either clicking on Yes or No the complying
solutions will be displayed one at a time, see below. By clicking on the Yes button a copy of these result can be sent
to your printer. Clicking on No will proceed to next solution. Clicking on Cancel will abort displaying the solutions &
return to the original input screen.
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At the bottom of the input screen you will see a field named UWLR Limiting Angle. The value that goes in this field
can be calculated by using the next module.

7.6 Upward Waste Light Ratio

One of the light technical parameters (LTPs) to be considered when designing road lighting installations, in
accordance with AS/NZS 1158, is the Upward Waste Light Ratio (UWLR). The UWLR is defined as the proportion of
luminous flux emitted above the horizontal (taking into account any upcast of the luminaire) compared to the total
emitted by the luminaire.
While the V Category Lighting module automatically calculates the UWLR, it may be necessary to separately calculate
UWLR for a range of angles for a particular luminaire and this is where this program is used. The screen below is
initially displayed into which you input the name of the file containing the photometric I-table and the range of
angles to use. Insert values as shown and press the Calculate button.

An output screen as below will be shown, as previously one can print or save these results.
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AS/NZS1158.4:2009 currently states the maximum UWLR for a zebra crossing is 2%. So this program can be used to
determine the maximum angle ie. UWLR Limiting Angle referred to in Section 7.5.
Note: CIE/SAASTAN photometric i-table data is required for this program. If you only have IESNA data, for the luminaire
under investigation, then it can be converted to the CIE/SAASTAN format by using the program described in Section 7.3.
Note: See the Frequently Asked Question titled Upward Waste Light Ratio results differ between Perfect Lite &
Photometric Toolbox at http://www.perfectlite.com/faq.htm for some important information on the UWLRs calculated by
different programs.
Enough of these minor distractions, let’s get onto the most important part of Perfect Lite for Windows namely, the
Project menu. This is used for flood lighting and roadway lighting (illuminance) design checking.
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8. PROJECT MENU
This Section will also use some parts of the File menu that we have not touched on as yet.

8.1 New Project
The project or job we will create is a basic Tennis Court and is shown on the sketch in Section 11. The same
procedure can be used for a street light application.
Let’s start by inputting a ‘new’ project into the program, then carry out some calculations followed by displaying the
results. From the File menu click on New Project as below.

You will be presented with a question as below, in our example click on No.

The following screen will be displayed but initially with all blank fields .

8.1.1 File Name and Job Title
In the first field, input the name of the file to hold the project details, in our case type in tut01 (upper or lower case it
doesn't matter). In the previous DOS PLE program this filename was limited to 8 characters. However, Perfect Lite for
windows allows long file names with virtually no restrictions.
In the second field, input a description for the project, say Tutorial test run no. 1 and then click on the Next button
for the program to continue. Note: This file can ONLY be saved in the default Project folder as set in the Options
menu.

8.1.2 Locating Poles and Attaching Luminaires
The screen will change and show blank fields where the location/height details of the first pole (.ie. Current Pole no.
1) is to be input. Don't worry about the buttons on the top right part of the screen as yet. Type the data as shown into
the respective fields (press Tab to quickly move between the data input fields).
In the lower part of the screen type the following data into the respective fields on the first line (i.e. Position No. 1).
The values in the Maintenance Factor column will initially be the value set in Section 3.1 but can be changed here as
required.
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On the second line (i.e. Position No. 2) starting with the cursor in the left most field press Ditto from Field Above
button which will duplicate the data from the field above, press Ditto from Field Above button again and in the third
field input 10, press the Tab key then Ditto from Field Above button to duplicate the last field.

As shown to the right of the screen, you can click on the Library button to view a summary listing of the luminaire
Library should you forget the code number you want to use. Click on the Next Pole button for the program to accept
the two lights on this pole, the screen will change and move onto an input screen for Current Pole no. 2.
Now in our case, the poles are symmetrically positioned around the tennis court so we can add the remainder of the
poles using the special buttons rather than manually typing the details of each pole/light as we have done so far.
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8.1.3 Additional Buttons
On the right hand side of the screen, you will now see shown all the additional buttons that can be pressed to
perform special tasks to make life just that little bit easier. Some of these buttons may be ‘greyed’ out at times
indicating that that function is not available at that time.

In our case we will use the Mirror Poles in X or Y Plane button to duplicate the first pole about the centre of the court.
Press the Mirror Poles in X or Y Plane button and an input screen will appear. We will now duplicate pole no. 1 to
pole no. 2 position by entering 18 and pressing Ok as shown bellow.

The underlying program screen will now change requiring details for Current Pole no. 3. To duplicate pole nos. 1 and
2 (to positions 3 and 4) press the Mirror Poles in X or Y Plane button again and input 9.5 and pres Ok as shown
below.

Isn't this easy when inputting a symmetrical layout, particularly if there is a number of poles involved.
As we have no further poles to add (i.e. finished inputting) just press the Next Pole button with the top two fields
blank and the program will save the layout data to the previously nominated file. A confirmation question will be
asked, so just respond by clicking on Yes.
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Now that we have created the ‘layout file’ for this new project we have to define the ‘calculation field’ and what ‘type
of calculation’ is to be performed etc. Fortunately, the program is intuitive enough to realise this and it therefore
bypasses the main menu screen and goes directly to the module of the program where the calculation field etc. is
defined.

8.2 Define Calculation Field
This part of the program can also be arrived at by clicking on the Define Calculation Grid menu option.

8.2.1 Calculation Type

The screen above will first appear. In our case, the top parts of the screen are satisfactory as is. We jus t need to add
values in the lower part. I’ll let you explore the other choices at the top of the screen at a later time.

8.2.2 Grid Dimensions
The next series of input fields is where you inform the program of the size of the grid area (calculation field) over
which you want the point by point calculations performed. Input values as below:
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The values above will calculate the levels over an area 36 metres (18 x 2) in the X direction by 19 metres (19 x 1) in
the Y on a horizontal plane 1 metre above the ground (i.e. the height of the court net). Press the Next button when all
the values have been inserted.
Now that we have defined the type of calculations, the program will again bypass the main menu screen and go to the
point where the actual mathematical lighting calculations are performed.

8.3 Calculate
This part of the program can also be arrived at by clicking on the Calculate menu option.

The field now on the screen (see below) is to contain the name of the file holding the layout of poles/lights to be used
for the calculation of illuminance/luminance. The field will contain the name of the current layout file and therefore
will usually not require changing.
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If you want to use a different file then input its name here or alternatively press the Browse… button to bring up
directory window from which to choose a suitable file name.
When the required file name is in the field press the Calculate button for the program to commence its calculations.
As the calculations proceed the display will change to show the progress.

If the After calculation completed, automatically proceed to draw contours check box is ticked then the program will
again bypass the main menu screen and go to the point where the contours are drawn. This will be described in the
next Section.

8.4 Isolux Diagram
The calculated results can be viewed in several ways, some are described below.
This part of the program can also be arrived at by clicking on the Isolux Diagram menu option.
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Your display will automatically change to full screen and show a dialog box where you can nominate several items
in order to display the results graphically on the screen in the form of contours. You will notice on the top of this
screen a field where you nominate a scale. This field can generally be left as is. Further down the page is where you
nominate what contour levels you want drawn, input into these fields the following values 50, 100, 150, 175 and 200.
Leave the Shape File and AutoCAD DXF File fields blank and put a tick in the Show Grid Points check box. Now press
the Draw Contour button for the program to draw the contours.

The screen should first blackout and a red bordered area will be drawn representing the calculation field over which
the last calculations were performed. Tick marks along the edges and "+" symbols across the screen will indicate the
grid specified. Contours will be drawn for the nominated values and the positions of the poles will be shown as a
circle with dotted lines from it to the aim points on the ground for each light.

Several actions can now be taken with this display as will be shown by the Menu Bar to the right of the screen. If you
want, this Menu Bar can be moved around the screen by holding down the left mouse button over the blue area and
moving it to somewhere else on the screen

8.4.1 Mounting Positions and Aim Points
Click on the Poles menu button and you will see the poles and aim points disappear, press the button again and they
will re-appear, amazing isn't it…. This function, as with several others, simply toggles between two states, in this case
between showing the pole/aim points and not.
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8.4.2 Display Statistics
Now click on the Statistics button and at the top of the screen will be displayed a window showing some information
about the current grid. Click the Continue button to return to select another function.

8.4.3 Levels at Grid Points
Now click on the Levels button, after a moment or two the actual grid point levels will be drawn across the screen.
Click on the button again and the displayed levels will be erased.

8.4.4 Zoom into Smaller Area
Now for something a little more useful, let us look at a part of the display in more detail (i.e. zoom into a smaller
area). Click on the Zoom In button and the following message will appear.

Click on the Ok button, and as the message says, click on one corner of the zoom window then click on the opposite
corner. As you move the mouse cursor around the screen the changing co-ordinate will be indicated on the bottom
line of the screen. A white rectangular will define the zoom window. However, the actual zoom window will be based
on the grid increments.

The display will now be re-drawn with the selected area enlarged to fill the screen.
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You can of course, zoom in further if you wish by repeating the above procedure. This ‘zooming’ comes into real use
where you have an intricate Shape or DXF file displayed on the screen, I will discuss this more a little latter.
Click on the Restore button to restore the display to its original size.

8.4.5 Graphics Printer Output
Now let us get a hard copy of these contours on your printer, to scale of course. On the screen at this point you
should have the original contour diagram, now click on the Print button. The display will change to show a data
input screen where you can nominate the required scale and what items you want included in the printout.

As a start it will use the current system default printer, if you want another printer then click on the Change Printer
button and select an alternate. For our example, just leave all the check boxes as they are and click on the Print
button. Depending on the speed of your computer/printer and resolution of the output it might take up to several
minutes for this print to finish.
When printing has finished the screen will return to displaying the contours and further selection from the menu.
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8.4.6 AutoCAD DXF File Creation
Those who use a CAD package will probably be aware of the term DXF file (general purpose file format for exchanging
details of drawings between different CAD programs). The Perfect Lite for Windows program can both read (some
limitations apply) and write data in this format so drawing/contour information can be easily exchanged between
Perfect Lite for windows and your CAD package.

8.4.6.1.1 General Principles in using DXF Files
The scenario for a lighting design project might go something like this:
You have the drawing on your CAD system for a sports field, car park or road intersection that you
have to illuminate. You create a DXF file (using the 'DXFOUT' command) from this drawing. Now
you start up Perfect Lite for Windows and create a new project, input light positions, define the
calculation field, carry out the calculations and bring up the input screen to draw contours in the
usual way. On this screen you specify the DXF file and conversion factor in the appropriate fields.
This will display the contours with the AutoCAD? drawing shown over it. You can then modify the
design in the usual way until you arrive at the final design. You then create a DXF file containing
this lighting design, copy this file back to your CAD sub-directory, load it into the CAD drawing
(using the 'DXFIN' command) and manipulate it as part of the CAD drawing for your client.

8.4.6.1.2 Reading a DXF File
Let us try out part of this procedure for real. Let us assume we have already created a DXF file called TENNIS.DXF
from an AutoCAD ? drawing for our sample tennis court job.
So as normal, go to the part of the program where you draw the contours eg. menu selections - File, Project, Isolux
Diagram. On the data input screen input tennis into the field named AutoCAD DXF file and 1000 into the Drawing
units/m field and then press the Draw Contour button.

The contours will be drawn as before, then the DXF file. The DXF file we have used is only a very simple one, however,
depending on the complexity of the file it may be necessary to Zoom into a smaller part of the display to get a better
appreciation of the quality of lighting in a particular area. In our example the DXF file is displayed as a yellow
dashed line.
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8.4.6.1.3 Creating the DXF File
On this graphics screen, click on the Create DXF button. The screen will clear and display several input fields and
check boxes (like when outputting to the printer) where you nominate what parts of the current project you want
included in the DXF file. Note the default file name will be that of the current project so unless you want to use some
other name leave it as it is.

Click the Create DXF button for the program to start creating the DXF file. When finished click on the Ok button to
return to the isolux diagram screen. If you have a CAD package then when you have finished this User Guide start a
new drawing and load this DXF file into it using the DXFIN command and view the results. Be careful to ensure you
have loaded the Text style name as specified on the Options… menu of the program. If you don’t this may cause the
DXF file to abort loading.

8.4.6.1.4 Correct Alignment
Both when reading and creating DXF files in Perfect Lite for Windows it is essential to have a) the correct conversion
factor and b) the same co-ordinate origin. If not, the DXF file when drawn will only appear a fraction of its actual
size and/or it will not align correctly with the contours and calculation field etc..
Let us now view the results of the project just calculated in a different way. There are several ways this can be done,
either numerically or as pseudo-shading on either the screen or on the printer.

8.5 Quick Display of Results
On the main Perfect Lite for Windows menu select Quick Display of Results.
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The dialog box below will appear where you can select what you want included.

After clicking on Display the screen will change to show the schedules etc.. From here you can print it or save it to a
text file.
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Click on the Close button to continue. The actual illuminance levels at each grid point of the calculation field will
now be shown. You will note that around the edge of the display is indicated the X and Y dimensions of the
calculation field. Two of the values within the table are shown in a slightly different colour this is to indicate the
points where the minimum and maximum levels occur. Illuminance levels are always rounded to the nearest whole
number unless below 1lx when they are shown to 1 decimal place. Luminance levels are always rounded to two
decimal places.
Due to the size of our calculation area (actually can be up to a maximum of 160,000 grid points) only part can be
displayed across the screen at any one time. Use the scroll bar to view more down the page.

When finished viewing, click on the Close button to return to the main Perfect Lite for Windows menu screen.

8.6 Uniformity Window Information
Anytime after calculations have been performed, you can define up to three rectangular sub-areas or windows within
the calculation grid where the program will determine the minimum, maximum, average and several uniformity
ratios.
Invoke this by clicking on the Uniformity Windows selection on the Project menu.

The screen will change to show some more input fields which can be used to define part or all of the calculation field
where these values will be determined. By default, the whole calculation area will be selected as shown by the
values along the top line of input fields. We will get the program to find the respective values for the playing area as
well, so input "3", "15", "4", and "15" into the fields on the second line. Then click on the Next button.
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The summary results will be immediately displayed as shown below, where once again you can print or save.

Clicking on the Close button will return you to the main Perfect Lite for Windows menu.

8.7 Archiving Results
At any time when using the program you can save the state of the current job by Archiving it. However, each time you
start Perfect Lite for Windows it will automatically load itself up with the last job you were using, so you do not have
to archive the current job each time you terminate Perfect Lite for Windows.
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Nevertheless, when you start a ‘new’ project and you have not completed the current job (i.e. reached final design
stage) then it is recommended you archive the current job before starting the new one. This way you will be able to
return to the ‘old’ job in the future by ‘retrieving’ it.

8.7.1 Archive
To archive the current job click on the Save Project (Archive) button.

The dialog box below will appear where you can nominate the file name under which it will be saved. By default it
will contain the current project name. Either change the name or leave as is and click on the Proceed button.

Archiving will then commence with progress shown on the screen, click Ok when finished.

8.7.2 Unarchiving a Previous Project
Let us say we now want to retrieve a previous job (e.g. a Petrol Service Station) as it so often happens in real life the
client wants a minor modification, different luminaires are to be used. Select the Retrieve Project (from Archive)
button on the main menu screen.
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Into the subsequent input field you enter the name of the archived file, let us say we forget the name of the file so we
click on the Browse… button. A standard file dialog box will appear that shows all the previously ‘archived’ files.
Select the one named STATION.plr.

After clicking on the Open button, click on the Proceed button to continue.

The progress will be displayed within the box on the screen.
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Finally, click on the Ok button then the Finish button to return to main menu screen.
The following Section will deal with modifying this ‘retrieved’ job.

8.8 Modify Project
On the main Perfect Lite for Windows menu select the Modify Layout.

The procedure to modify a job is much the same as starting a new job except that most of the input fields will already
contain data extracted from the previous job. Unless you want to change a lot of data you generally just click the
Next (or default) button numerous times to proceed quickly through the file. However, there are several short cuts
buttons to achieve some common steps.

8.8.1 Input Filename, Output Filename and Job Title
The first screen will show a field where you enter the name of the file containing the layout details of the project you
want to modify (i.e. Input File Name). This field will already be filled with the name of the job we have just
unarchived (i.e. STATION) so we won't need to change it. If we wanted to change it we could either just type the file
name required or click on Browse… button to select a file from a directory list.
The second field on this screen is the name of the file where you want to the modified data to be stored (i.e. Output
File Name). Depending how you ‘setup’ Perfect Lite for Windows (see Section 3.1) the name in this field may either be
the same as the input file or the input file incremented by '1'. Unless you want a particular name here just accept
what has been placed in the field by the program. The next field contains the title for the current job, generally you
wouldn't change this either.

Perfect Lite for Windows – User Guide (Version 5.05)

Page 48

8.8.2 Modify Method Menu
A series of radio buttons are at the bottom of this window where you select the ‘method’ you want to employ to
modify the current luminaire layout. As we have to change the type of luminaire used this is best done by selecting
Luminaire Code Bulk Change.
Click on the Next button to accept the screen and continue on with the program.

8.8.3 Exchanging Luminaire Types
The screen will change and the lower portion will show all the different luminaire code numbers and flux values used
in the current layout file being modified. Type 8 into the first field, as this is the one we want to change, press Tab
and type 21 into the second, 31.43 into the third, 0.7 into the fourth then click on the Next button to carry out the
changes.

The lower part of the screen will change and list the poles and lights that were changed, press Ok to continue on with
the program.
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The program will now automatically skip to the module where the illuminance calculations can be performed. Press
Calculate button to start the calculation process.

When the calculations are finished the program will go to the part in the program where the contours will be drawn
(providing After calculation…….draw contours check box is ticked).
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Click on the Draw Contour button to continue, if a message such as INSERT/BLOCK found but ignored! appears simply
click on the Ok button. This is to signify that Perfect Lite for Windows does NOT read any ‘Blocks’ contained in a DXF
file. To get around this you might have to ‘explode’ your drawing before creating the DXF file.

From here you can click on the appropriate Menu Bar buttons on the right to zoom in or just exit back to the main
menu screen.
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9. HELP MENU

Choices from this menu are reasonably self-explanatory, see also Section 1.2 for a little more detail.
The About selection will display a screen as below giving some important system information that may be needed if
requiring some support.
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10. CONCLUSION
You have now completed the User Guide and I hope you have obtained a reasonable appreciation of the suite of
programs in the Perfect Lite for Windows package. Please feel free to explore the many other features of the
program/s not explained in this User Guide.
Also, don't hesitate to email me to discuss any problems you may have in using the program/s. Problems can arise
simply because of your unfamiliarity with the program/s and concepts used in other programs which may not be
applicable in Perfect Lite for Windows. These sorts of problems can be easily and quickly fixed with the end result
being that you will get a better appreciation of the program.

The Perfect Lite for Windows range of software will be enhanced from time to
time and any suggestions on future improvements or additions
are always welcomed from both users and evaluators alike.
Send your suggestions to: support@perfectlite.com
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11. SAMPLE PROJECT - TENNIS COURT
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12. SAMPLE PRINTER OUTPUT

PLEASE NOTE: Quality of the actual printout on your printer may be better than shown here.
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